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 About DMTI Spatial ™ 
 
DMTI Spatial Inc. is Canada’s leading spatial solutions provider.  We enable users to understand their 
customers, optimize resources, realize opportunities, maximize profitability and make more informed 
decisions through accurate products and innovative thinking. 
 
DMTI Spatial publishes precision built street map, rail and routing data (CanMap®), a detailed water layer, 
and innovative geocoding and address management software (GeoPinpoint™).  In addition, DMTI Spatial 
publishes a full range of positionally accurate geospatial data products including: enhanced points of 
interest (EPOI), census data and boundaries, postal geography, topographic maps, and US mapping 
data.  As part of a complete business geographic solution, DMTI Spatial offers a wide range of GIS 
services, consulting, and software training. 
  
Established in 1994, DMTI Spatial is committed to setting the standard within the GIS industry for 
precision built spatial data and geocoding software products. 
 
At DMTI Spatial, we believe that our true strength comes from working closely with our customers and 
providing innovative solutions to meet their strategic business objectives.  As Canada’s premier spatial 
solutions provider we pride ourselves with having worked with North America’s leading organizations to 
support their mission critical applications.  
 
DMTI Spatial works with large and small organizations representative of a wide variety of industries:   
 

• Agriculture 
• Banking/Finance 
• Consulting 
• Education 
• Emergency Services 
• Engineering 
• Environmental 

• Forestry 
• Government 
• Health 
• High Technology 
• Insurance 
• Manufacturing 
• Media 

• Mining 
• Real Estate 
• Retail 
• Telecommunications 
• Transportation 
• Utilities

 
We are a member of the ESRI Canada Business Partner Program, and winner of the 2001 ESRI 
Worldwide New Business Partner of the Year Award and the 2005 ESRI Foundation Partner of the Year 
Award. We are a strategic business partner of MapInfo and winner of the Markham Board of Trade 2000 
Award for Entrepreneurship and Innovation.  Recipient of The Association of Canadian Map Libraries and 
Archives (ACMLA) 2002 Certificate of Appreciation. 
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Really Smart Spatial Solutions™  
 
Through the application of its products and services, DMTI Spatial has been involved with projects such 
as: location-based services, logistics planning, emergency dispatch, facilities management, data 
management, customer care, address management, land base development in support of network 
planning, and marketing/demographic analysis applications. 
 
DMTI Spatial can provide all of the components necessary for the acquisition, implementation, operation 
and maintenance of a successful GIS system within companies of all sizes.   Through its product and 
service offering, DMTI Spatial can provide users with 5 key components: 
 
1. Accurate, detailed, and compatible data 
2. Comprehensive maintenance program 
3. GIS software  

4. Consulting and services 
5. Software training 

 
DMTI Spatial™ Product & Service Portfolio
 
DMTI Spatial’s product & service offering 
includes: 

 
CanMap®  - Digital Map Data for Canada 
• CanMap® Streetfiles  
• CanMap® RouteLogistics 
• CanMap® Rail 
• CanMap® Major Roads and Highways 
• CanMap® Parks & Recreation 
• CanMap® Water 
 
Satellite Imagery  
• Satellite StreetView™ 
 
Municipal Amalgamations 
• CanMap® Municipality Amalgamation File 

(MAF) 
 
Business & Recreational Points of Interest  
• Enhanced Points Of Interest (EPOI)  
 
GeoPinpoint ™ Suite    
• Canada’s Geocoding Solution 
• Modular Architecture  
• Windows Standalone Desktop Version 
• UNIX, Java Wrapper, ActiveX (DLL Version)   
 
Topographic Data and Base  Maps  
• Canadian Atlas Map Bundle (CAMB) 
• Populated Placenames  
• National Topographic Data Base (NTDB) 
• 30 & 90m Digital Elevation Models (DEM) 
• Clutter Data  
 
Postal Geography & Data   
• Six-Digit Postal Code File (LDU)  
• Enhanced Postal Code File (MEP) 
• Forward Sortation Areas (FSA) Boundary 

File 

 
 
 
 
 
1996 Census Boundaries & Demographic Data 
• Enumeration Area (EA) 
• Census Subdivision (CSD) 
• Census Division (CD) 
• Census Metropolitan Area/Census 

       Agglomeration (CMA/CA) 
• Census Tract (CT) 
• Federal Electoral Districts (FED) 
 
2001 Census Boundaries 
• Dissemination Area (DA) 
• Census Subdivision (CSD) 
• Census Division (CD) 
• Census Metropolitan Area/Census 

       Agglomeration (CMA/CA) 
• Census Tract (CT) 
• Federal Electoral Districts (FED) 
 
GIS Software  
• Contour Modeling and Display 
• Demographic Profiling and Lifestyle Targeting 
• Geocoding and Mapping Software 
• Routing and Logistics 
 
Consulting and Services 
• Application Development 
• Database Marketing 
• Data Conversion and Creation 
• Database Scrubbing 
• Geocoding Services  
• GIS Consulting 
• Technical Support 
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Error Reporting & Wish List Services 
 
DMTI Spatial is committed to building the best products possible for our customers.  By using our data 
every day in your mission critical application you are our best product tester.  Please let us know if you 
have found an error in any of our products so that we can make the correction for the next release. 
 
This is your opportunity to provide feedback directly to the DMTI Spatial Product Development Team.  
Please be as specific as possible so that we can improve our products quickly and accurately.  To access 
the Error Reporting Web page please visit http://www.dmtispatial.com/feedback.htm or send an e-mail to: 
fixme@dmtispatial.com  
 
If you have an idea for a new product or an existing product enhancement, please submit your ideas to 
the Wish List Web page: http://www.dmtispatial.com/wish_list.htm or send an e-mail to: 
wishlist@dmtispatial.com  
 
Over the coming months DMTI Spatial will keep you informed of new product releases, enhancements 
and strategic alliances.  Our goal is to provide you with powerful knowledge based tools to help you attain 
and maintain your competitive advantage.   
 
Contact Information 
 
DMTI Spatial Inc. 
625 Cochrane Drive, 3rd Floor 
Markham, Ontario 
L3R 9R9 Canada 
 
Telephone: 905-948-2000 
Toll Free: 1-877-477-DMTI (3684) 
Fax: 905-948-9404 
 
Web Site: www.dmtispatial.com 
E-mail: info@dmtispatial.com 
Error Reporting Service: fixme@dmtispatial.com  
Product Wish List Service: wishlist@dmtispatial.com 
Technical Support: support@dmtispatial.com  
 
Trademarks and Notices 
 
© 2005 DMTI Spatial Inc. CanMap is a registered trademark of DMTI Spatial Inc. DMTI Spatial, Really 
Smart Spatial Solutions, Because Where Is What Matters, and GeoPinpoint are trademarks of DMTI 
Spatial Inc.  All rights reserved.  Other products and company names mentioned herein may be 
trademarks of their respective companies.  Mention of third-party products is for informational purposes 
only and constitutes neither a recommendation nor an endorsement. 
 
DMTI Spatial is an Authorized User and Distributor of selected Statistics Canada Computer File(s) under 
Licensing Agreement 6228.  No confidential information about an individual, family, household, 
organization or business has been obtained from Statistics Canada. 
 
© Copyright, HER MAJESTY THE QUEEN IN RIGHT OF CANADA, as represented by the Minister of 
Industry, Statistics Canada 2003. 
 
Digital Topographic Data produced under License from Her Majesty the Queen in Right of Canada, with 
permission of Natural Resources Canada and The Queen in Right of Manitoba. 
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 About  Satellite Streetview™ V2005 
 
Satellite Streetview TM Product Description 
 
Satellite StreetView is an innovative new geospatial data product, which combines the spatial detail of 
high-resolution satellite imagery with the rich data content of a digital streetmap. 
 
This product is an integrated dataset of orthorectified and seamless mosaicked QuickBird Satellite’s 
pansharperned data combined with CanMap streets. It provides the highest commercially available 
spatial resolution satellite imagery at 60cm along with boundary and point data to ensure a full range of 
positionally accurate geospatial data products. 
 
 
QuickBird Satellite Imagery Properties 

 
The QuickBird satellite provides images in five bands, one panchromatic band  and four multispectral 
bands.  The panchromatic band  has a spatial resolution of 60 cm and spectral resolution of 450 – 900 
nm.  The four multispectral bands  do not overlap and have a spatial resolution of 2.44 cm, with spectral 
resolutions of blue: 450 – 520 nm; green: 530 – 600 nm; red: 630 – 690 nm; near IR 760 –900 nm. 

 
Satellite StreetView image data is orthorectified and pansharpened to combine the colour information of 
the multispectral bands with the spatial information of the panchromatic band. The generated images are 
then mosaicked to ensure a seamless view of a particular coverage area. 

 
 

Orthorectified Imagery Properties 
 

The orthorectified imagery are radiometrically corrected, sensor corrected, geometrically corrected, 
orthorectified, and mapped to a cartographic projection and datum. 

 
Digital elevation models (DEM) and accurate ground control points (GCPs) are used to orthorectify the 
satellite imagery.  This removes the relief displacement and places each pixel into its correct, map 
location.  

 
Table 1. Orthorectified imagery properties 

 
Property Description 

  Applied Corrections 
� Radiometric 
� Sensor 
� Geometric  

  Image Processing 
� Spatial mosaicking applied (images mosaicked to minimize 

seamlines) 
� Color balance applied 

  Map Projection  UTM Zone 
  Datum  WGS84 
  Map Accuracy  1:10,000 ortho accuracy  
  Ortho Accuracy  5.15-metre RMSE (8.47-meter CE90%) 
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About  Satellite Streetview™ V2005 (cont’d) 
 
Tiling and Naming Conventions  

 
Image Tile 
 
Satellite StreetView imagery products are tiled into 14,000 pixels by 14,000 pixels. 
 
For users convenience, pixel-based grids define image tiles and the following is an example of a 
typical image tile specification: 
 

Tile Size File Size Number of image 
bands 

Bit Depth 

14000 by 14000 pixels  560 MB 3 bands 8 bit 

 
Tile Naming Conventions 
 
Satellite StreetView imagery naming provides key information about the tile identification, acquisition 
date of the images used, area identification, product level and file format extension. 
 

 
 Figure 1. Final Product structure showing tile size  and naming 
  convention. 
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About  Satellite Streetview™ V2005 (cont’d) 
 
The image tile naming parameters are: 

 
Tile Identifier Acquisition Date 

Range 
Area Identifier Product Level File Format 

Extension 

1_1 = column1, row1 
1_2 = column1, row2 
2_1=  column2, row1 

02Apr_05May = 
oldest image date 
and most recent 
image date used in 
mosaic 

Toronto_1 = Name of city 
or region followed by 
number of update 
indicator 

S = Pan Sharpened 
3X = Ortho 
3G = DG Ortho 
M =  Mosaic 
S= Single/Sub-
scene 

TIF = GeoTIFF 

 
 
CanMap Street Files 

 
Layer Properties 
 
Property Description 
Coverage National 
Currency June 2005 
Level of Accuracy Ranging from the National Topographic Data Base (NTDB) standard to sub-

meter accuracy 
Projection All layers are displayed in UTM 
Datum All layers are in WGS84 datum 
Format ESRI and MapInfo1 

 
 
 
 

                                                      
1 Custom formats available upon request.  Refer to Appendix A: ESRI File Extensions and Appendix B: MapInfo File Extensions for 
more information regarding file extensions. 
2 Where AREA refers to a DMTI Spatial Standard Geographic Area 
3 Casements not available in ArcInfo Interchange Format (*.e00) 
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About  Satellite Streetview™ V2005 (cont’d) 
 
 
Directory Structure 

 
Satellite StreetView products delivery consist of Satellite Imagery and CanMap Streetfiles with a set of 
metadata files for both for MapInfo® and ESRI® users. 
 
 File Description and Layout 
 
This section describes the structure of the Satellite StreetView directories.  Below is a tree diagram (figure 
1) of the Satellite StreetView directory and a table listing (table 1) of it’s content: 
 
 

 
 
Figure 1.  Directory Structure Tree Diagram 
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Directory Name  File Type Description File Extension  

Image Metadata File Key attributes about the image 
product, image description, 
projection information and 
acquisition date 

.TXT 

Tile Metadata File Information about number of tiles 
included in the delivery with file 
names and corner coordinates for 
each tile 

.TXT 

License File DMTI Spatial End User License 
Agreement 

.PDF 

SSV_Product_Specifications An overall view of the product in a 
tabular format 

.PDF 

Documentation 

SSV_User_Manual Information about the data used 
to generate the product and 
instructions for viewing the 
product in an GIS environment 

.PDF 

CSD File The Census subdivision 
boundaries covered by the SSV 
product extent  

.SHP or .TAB 

Mosaic_Cutline The mosaic cutlines used to 
generate the final image product 

.SHP or .TAB 

GIS_Files 

Tile_Shape Polygon description of each image 
tile 

.SHP or .TAB 

Imagery Image File Image tile .TIFF 
Streetfiles Street File CanMap Streetfiles .SHP  or .TAB 

City Overview File A compressed JPEG image 
showing the SSV image coverage 
with census subdivision boundary 

.JPEG 

Tile Layout File Compressed JPEG image 
showing the tile names with the 
SSV image coverage 

.JPEG 

Layout Files 

Product Overview File File is either an ArcMap project 
file or a MapInfo workspace 
showing the product layout 

.MXD or .WOR 

 
Table 1.  Directory Content  
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Using Satellite Streetview™ V2005 
 
Viewing DMTI Spatial Products 
 
Packaged with DMTI Spatial products are several custom viewing files for MapInfo® Professional, ESRI® 
ArcView® GIS and ESRI® ArcGIS®. 
 
Software Extension Version Support 
MapInfo Professional  *.wor Version 4.5 and higher 
ESRI ArcView GIS *.apr Version 3.0 and higher 
ESRI ArcGIS  *.mxd Version 8.1 and higher 
 
Located in the product directory, these viewing files have been provided to maximize the ease of use of 
DMTI Spatial products by intelligently layering various data layers and displaying them based on 
appropriate viewing scales.  
 
 
Viewing Satellite StreetView TM Imagery  

 
This section provides instructions for viewing Satellite StreetView imagery products in ArcMap®, a 
part of ESRI® ArcGIS® suite and for MapInfo® Professional. Satellite StreetView imagery products 
are delivered in 8-bit image depth as both ArcMap® and MapInfo® Professional are able to load and 
display 8-bit imagery. 

 
Viewing in ArcMap® 

 
Satellite StreetView ESRI imagery TIFF files are provided with .RRD files to improve the performance 
and display quality of the raster dataset and .AUX files that stores any auxiliary information like 
statistical information, coordinate system, histogram for the raster dataset.  
 
To view an image in ArcMap follows the steps. 
 

o To view an image, click the ‘Add’ button and choose the image file to be displayed 
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Using Satellite Streetview™ V2005 (cont’d) 
 

 
 Figure 2.  To view the image by clicking the Add b utton 

 
If you wish to change the display quality of the image,  here is an indication of the steps to be 
followed: 
 

o Once the image is in the table of content, right click the image and select ‘Properties’ from the 
pop-up list. 

o Layer Properties Dialog will appear. Choose the ‘Symbology’ tab.  
o Make sure the default selection ‘RGB Composite’ is selected under the ‘Show’ box. 
o Change the “Stretch’ setting to any option other than ‘None’. 
o ESRI’s online help provides description of each stretching option in detail. The purpose of this 

document is only to bring the image to a viewable state.  
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Using Satellite Streetview™ V2005 (cont’d) 
 
 

 
 Figure 3.  The Layer Properties Dialog box to chan ge the display quality of an image. 
 
 
Viewing In and MapInfo® Professional 
 
Satellite StreetView imagery are provided in 8-bit image depth and can be loaded and viewed in 
MapInfo®  Professional. 
 
To view an image in MapInfo follow the steps. 
 

o To view an image, click on the file ‘Open’ button and choose either the TIFF file or the TAB 
file provided. 

o Once the image file is selected, right click to bring the ‘Layer Control’ panel. 
o On the ‘Layer Control’ panel go to ‘Display’ and turn off ‘Display within Zoom Range’ and 

press ‘OK’ to display the image. 
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Using Satellite Streetview™ V2005 (cont’d) 
 
 

 
 Figure 4. Use ‘Layer Control’ panel to display ras ter image.  
 

 
 Figure 5. Turn off ‘Display within Zoom Range’ to display image. 
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Using Satellite Streetview™ V2005 (cont’d) 
 
Viewing CanMap Streetfiles 
 
There are currently two viewing files available for reference, mapping and analysis. 
   
Filename Description 
AREArds Offers a limited number of files for reference purposes only. Opens and zoom layers 

capital cities, populated placenames, roads, major roads and highways, highways, 
municipality boundaries, and national water.  

 
CanMap Streetfiles workspaces or project files are found in the product directory: 
 
example:                              \CanMap\ON\ONrds 
 
 
 
Product Directory Geographic Area 

Directory 
Geographic Area 
Abbreviation 

Workspace/ 
Project File Type 

CanMap ON ON rds 
 
 
 
 
Other CanMap  layers 
 
Layer Description 
rds_lut Roads Lookup Table 
 



 2005 DMTI Spatial Inc.                                                                                                                                       Page 17 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
Not to be disclosed 

Data Dictionary
 
Census Subdivision Boundaries  
 

 
 
The CSD file contains the Census subdivision boundaries covered by the SSV product extent. 
 
Layer Location 
 \Streets\DATE_AREA_csd  
 

 
Layer Structure 
 

 
 
Layer Content 
 
The CSD file contains the Census subdivision boundaries covered by the SSV product extent. Census 
Subdivision (CSD) is the general term applied to municipalities or their equivalent and corresponds to the 
Statistics Canada 2001 Census Subdivisions.  Municipalities are comprised of political administrative 
entities such as cities, towns, or villages.  
 
 

Field Name Description 
NAME Census Subdivision Name 
AREA_SQKM Area (square kilometers) from Statistics Canada Land Base 
PROV Provincial/Territorial Abbreviation 
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Data Dictionary (cont’d)  
 
Mosaic Cutlines  
 

 
 
 
Layer Location 
 \Streets\DATE_AREA_mosaic_cutlines  
 

 
Layer Structure 
 

 
 
Layer Content 
 
The mosaic cutline file is provided to give information about DigitalGlobe image file name and the vintage 
of the imagery.  The file contains the mosaic cutlines used to generate the final image product. 

 
 
 
 
  

Field Name Description 
IMAGE ID Digital Globe Imagery file name 
VINTAGE Acquisition date of the imagery 
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Data Dictionary (cont’d)  
 
Roads (rds) 
 

 
 
Layer Location 
 \Streets\AREArds  
 
Layer Structure 
 
 Field Name  Type  Size  Description 
 STREET1    Character  69  Street Title (comprised of PRETYPE, PREDIR, STREETNAME, 

SUFTYPE, SUFDIR) 
 FROMLEFT  Decimal  6,0  Address on the Left side at the From end of the street segment 
 TOLEFT  Decimal  6,0  Address on the Left side at the To end of the street segment 
 FROMRIGHT  Decimal  6,0  Address on the Right side at the From end of the street segment 
 TORIGHT  Decimal  6,0  Address on the Right side at the To end of the street segment 
 PREDIR  Character  2  Prefix Direction component of the Street Title (e.g. W 5 St) 
 PRETYPE  Character  10  Prefix StreetType component of the Street Title (e.g. Rue Jean) 
 STREETNAME  Character  45  StreetName component of the Street Title (e.g. John  St E) 
 SUFTYPE  Character  10  Suffix StreetType component of the Street Title (e.g. John St E) 
 SUFDIR  Character  2  Suffix Direction component of the Street Title (e.g. John St E) 
 CARTO2  Decimal  3,0  Cartographic Road Classification 
 LEFT_MUN  Character  70  Municipality 
 RIGHT_MUN  Character  70  Municipality 
 LEFT_MAF  Character  70  Municipal Amalgamation 
 RIGHT_MAF  Character  70  Municipal Amalgamation 
 LEFT_FSA  Character  3  Forward Sortation Area 
 RIGHT_FSA  Character  3  Forward Sortation Area 
 LEFT_PRV  Character  2  Province (Abbreviation) 
 RIGHT_PRV  Character  2  Province (Abbreviation) 
 UNIQUEID  Decimal  9,0  Unique Identifier of Street segment 
Note :   Address fields contain only zeros in Unaddressed CanMap Streetfiles. 
 
Field Content 
 
Please note the Municipality (_MUN) fields are attributed with 2001 Census based Municipality names. 
1996 Census based Municipality names can be obtained by linking the rds  layer to the rds_lut  layer via 
the UNIQUEID and RDS_ID fields.  Also, all geocoding indexes have been created using 2001 Census 
based Municipality names. 

                                                      
1 For more information refer to Appendix C: Street Types and Street Directions 
2 For more information refer to Appendix D: Cartographic Road and Rail Classifications 
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Data Dictionary (cont’d)  
 
Roads Look Up Table (rds_lut) 1 
 
Layer Location 
 \Streets\AREArds_lut  
 
Layer Structure 
 
 Field Name  Type  Size  Description 
 RDS_ID  Decimal  9,0  UniqueId of related Roads (rds) segment 
 ALIAS_NAME  Character  69  Alternate Street Name 
 FORMERNAME2  Character  69  Former Provincial Hwy Name  
 HWY_NUM  Character  20  Highway Number(s) (e.g. Highway 404) 
 HWY_NUMNAM  Character  69  Road Numeric Name (e.g. Regional Rd 4) 
 HWY_NAME  Character  69  Highway Name Non-Numeric (e.g. Don Valley Pky) 
 RD_NUM  Character  20  Road Number (e.g. 4) 
 RD_NUMNAM  Character  69  Road Numeric Name (e.g. Regional Rd 4) 
 RD_NAME  Character  69  Road Name Non-Numeric (e.g. Taunton Rd W) 
 ALASKAHWY  Decimal  1,0  Alaskan Highway flag 
 CARIBOOHWY  Decimal  1,0  Cariboo Highway flag 
 CRWSNSTHWY  Decimal  1,0  Crowsnest Highway flag 
 DEMPSTRHWY  Decimal  1,0  Dempster Highway flag 
 JOHNHRTHWY  Decimal  1,0  John Hart Highway flag 
 KLONDKEHWY  Decimal  1,0  Klondike Highway flag 
 MCKNZIEHWY  Decimal  1,0  Mackenzie Highway flag 
 TRNSCDAHWY  Decimal  1,0  TransCanada Highway Flag 
 YELOWHDHWY  Decimal  1,0  Yellow Head Highway Flag 
 TOLL_RD  Decimal  1,0  Toll Road Flag 
 BRIDGE  Decimal  1,0  Bridge Flag 
 TUNNEL  Decimal  1,0  Tunnel Flag 
 BRUNNELNAM  Character  69  Bridge/Tunnel Name 
 TRAILNAME  Character  100  Trail Name 
 TRAILTYPE  Character  50  Trail Type 
 TRAILCLASS  Character  20  Trail Class 
 TRAILCODE  Decimal  4,0  Trail Code 
 L_MUN_96  Character  68  Municipality (1996 Census based) 
 R_MUN_96  Character  68  Municipality (1996 Census based) 
 
 

                                                      
1 For more information on joining the rds_lut Table to the rds Layer refer to Appendix F: Joining the rds Layer and rds_lut Table 
2 Applicable only in Ontario 
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Data Dictionary (cont’d)  
 
 
Trail Classes, Types and Codes 
 
TrailCode  TrailType TrailClass 
1000 OTHER PARK PARK 
1001 NATIONAL PARK PARK 
1002 PROVINCIAL PARK PARK 
1003 MUNICIPAL PARK PARK 
1004 CONSERVATION AREA PARK 
1005 NATIONAL HISTORIC SITE PARK 
1006 WILDLIFE/NATURE SANCTUARY PARK 
1007 EXHIBITION GROUNDS PARK 
2000 OTHER RECREATIONAL RECREATIONAL 
2001 HIKING/WALKING RECREATIONAL 
2002 BIKING RECREATIONAL 
2003 RIDING RECREATIONAL 
2004 SNOWMOBILE RECREATIONAL 
2005 SKIING RECREATIONAL 
2006 GOLF COURSE RECREATIONAL 
2007 PORTAGE RECREATIONAL 
3000 OTHER PRIVATE PRIVATE 
3001 TOWNHOUSE/CONDOMINIUM PRIVATE 
3002 SHOPPING MALL PRIVATE 
3003 TRAILER PARK PRIVATE 
3004 LOGGING ROAD PRIVATE 
3005 CEMETERY PRIVATE 
3006 ALLEY WAY PRIVATE 
3007 AIRPORT/HELIPORT PRIVATE 
3008 ABANDONED RAILWAY PRIVATE 
3009 INDUSTRIAL PRIVATE 
3010 FOREST SERVICE ROAD PRIVATE 
3011 REST AREA PRIVATE 
3012 SERVICE STATION PRIVATE 
3013 ABANDONED ROAD PRIVATE 
3014 COUNTRY CLUB PRIVATE 
3015 HOTEL/MOTEL PRIVATE 
3016 RETAIL/OFFICE PRIVATE 
4000 OTHER EMERGENCY SERVICES EMERGENCY SERVICES 
4001 HOSPITAL EMERGENCY SERVICES 
4002 FIRE ACCESS EMERGENCY SERVICES 
4003 EMERGENCY SERVICES ROAD EMERGENCY SERVICES 
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Data Dictionary (cont’d)  
 
 
Trail Classes, Types and Codes (con’t) 
 
TrailCode  TrailType TrailClass 
5000 OTHER EDUCATIONAL EDUCATIONAL 
5001 PRIVATE ELEMENTARY SCHOOL EDUCATIONAL 
5002 PUBLIC ELEMENTARY SCHOOL EDUCATIONAL 
5003 PRIVATE HIGHSCHOOL EDUCATIONAL 
5004 PUBLIC HIGHSCHOOL EDUCATIONAL 
5005 UNIVERSITY EDUCATIONAL 
5006 COLLEGE EDUCATIONAL 
5007 MILITARY SCHOOL EDUCATIONAL 
5008 SEPARATE ELEMENTARY SCHOOL EDUCATIONAL 
5009 SEPARATE HIGHSCHOOL EDUCATIONAL 
6000 OTHER GOVERNMENT GOVERNMENT 
6001 EXPERIMENTAL FARM GOVERNMENT 
6002 DEPARTMENT OF NATIONAL DEFENCE GOVERNMENT 
6003 CORRECTIONAL FACILITY GOVERNMENT 
6004 WEIGH STATION GOVERNMENT 
6005 PEDESTRIAN WALK WAY GOVERNMENT 
6006 POLICE TRAINING FACILITY GOVERNMENT 
6007 SEWAGE OR WATER TREATMENT FACILITY GOVERNMENT 
6008 NO PUBLIC ACCESS/BUS ROUTE GOVERNMENT 
7000 LIMITED USE ROAD: OTHER LIMITED USE ROAD 
7001 LIMITED USE ROAD: WINTER LIMITED USE ROAD 
7002 LIMITED USE ROAD: DRY WEATHER LIMITED USE ROAD 
7003 LIMITED USE ROAD: CART TRACK LIMITED USE ROAD 
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Data Dictionary (cont’d)  
 
Tile Shape  
 

 
 
 
 
Layer Location 
 \Streets\DATE_AREA_tile_shape  
 

 
Layer Structure 

 
 
Layer Content 
 
The Tile Shape file contains the polygon description of each image tile. It contains the tile name and gives 
the four corner coordinates for each tile. This file is provided to assist in determining what tile to look at a 
specific part of the delivered product. 

 

Field Name  Description 
TILE_NAME Image Tile Name 
UL_X Upper left X coordinate of the tile 
UL_Y Upper left Y coordinate of the tile 
LR_X Lower right X coordinate of the tile 
LR_Y Lower right Y coordinate of the tile 



©2005 DMTI Spatial  - Page 24  

Subject:www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
Not to be disclosed 

Appendix A: ESRI® File Extensions 
 
Refer to the following table for descriptions of ESRI file extensions.  All file extensions are not available 
for all DMTI products. 
 

File Extension ArcView  ArcGIS Both File Description 
*.shp   x Part of standard ESRI Shapefile 
*.shx   x Part of standard ESRI Shapefile 
*.dbf   x Part of standard ESRI Shapefile 
*.aih x   Part of Attribute Index 
*.ain x   Part of Attribute Index 
*.sbn   x Part of Spatial Index 
*.sbx   x Part of Spatial Index 
*.avl x   Legend Properties 
*.lyr  x  Layer Properties 
*.prj  x  Datum and Projection Properties 
*.apr x   ArcView Project file 
*.mxd  x  ArcGIS Project file 
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Appendix B: MapInfo® Professional File Extensions 
 
Refer to the following table for descriptions of MapInfo file extensions.   
 

File Extension File Description 
*.dat Attribute Data 
*.id Graphic Index 
*.ind Attribute Index 
*.map Graphic Data 
*.tab Tab File 
*.wor Workspace 
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Appendix C: Street Types and Street Directions 1 
 
Street Types 
 
Street Types used in the CanMap® suite of products correspond to the standard abbreviations used by 
Canada Post.   The Language column distinguishes between street types in English (E) and street types 
in French (F). 
 
Street Type Abbreviation Language  Street Type Abbreviation Language 

Abbey ABBEY E  Crescent CRES E 
Acres ACRES E  Corners CRNRS E 
Allée ALLÉE F  Croissant CROIS F 
Alley ALLEY E  Crossing CROSS E 
Autoroute AUT F  Court CRT E 
Avenue AV F  Centre CTR E 
Avenue AVE E  Dale DALE E 
Bay BAY E  Dell DELL E 
Beach BEACH E  Diversion DIVERS E 
Bend BEND E  Downs DOWNS E 
Boulevard BLVD E  Drive DR E 
Boulevard BOUL F  Échangeur ÉCH F 
By-Pass BYPASS E  End END E 
Byway BYWAY E  Esplanade ESPL E 
Centre C F  Estates ESTATE E 
Campus CAMPUS E  Expressway EXPY E 
Cape CAPE E  Extension EXTEN E 
Carr CAR F  Farm FARM E 
Carrefour CARREF F  Field FIELD E 
Cul-de-sac CDS E  Forest FOREST E 
Cercle CERCLE F  Front FRONT E 
Chemin CH F  Freeway FWY E 
Chase CHASE E  Gate GATE E 
Circle CIR E  Gardens GDNS E 
Circuit CIRCT E  Glade GLADE E 
Close CLOSE E  Glen GLEN E 
Common COMMON E  Green GREEN E 
Concession CONC E  Grounds GRNDS E 
Côte CÔTE F  Grove GROVE E 
Cour COUR F  Harbour HARBR E 
Cours COURS F  Heath HEATH E 
Cove COVE E  Highlands HGHLDS E 
 

                                                      
1 Source: Canada Post Corporation, The Canadian Addressing Guide, October 2002 
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Appendix C: Street Types and Street Directions (cont’d)  
 
Street Type Abbreviation Language  Street Type Abbreviation Language 

Hill HILL E  Private PVT E 
Hollow HOLLOW E  Promenade PROM E 
Heights HTS E  Quai QUAI F 
Highway HWY E  Quay QUAY E 
Île ÎLE F  Ramp RAMP E 
Impasse IMP E  Rang RANG F 
Inlet INLET E  Road RD E 
Island ISLAND E  Rond-point RDPT F 
Key KEY E  Range RG E 
Knoll KNOLL E  Ridge RIDGE E 
Landing LANDNG E  Rise RISE E 
Lane LANE E  Ruelle RLE F 
Line LINE E  Row ROW E 
Link LINK E  Route RTE E 
Lookout LKOUT E  Rue RUE F 
Limits LMTS E  Run RUN E 
Loop LOOP E  Sentier SENT E 
Mall MALL E  Square SQ E 
Manor MANOR E  Street ST E 
Maze MAZE E  Subdivision SUBDIV E 
Meadow MEADOW E  Terrace TERR E 
Mews MEWS E  Thicket THICK E 
Montée MONTÉE F  Townline TLINE E 
Moor MOOR E  Towers TOWERS E 
Mount MOUNT E  Trail TRAIL E 
Mountain MTN E  Turnabout TRNABT E 
Orchard ORCH E  Terrasse TSSE F 
Parade PARADE E  Vale VALE E 
Parc PARC F  Via VIA E 
Passage PASS E  View VIEW E 
Path PATH E  Villas VILLAS E 
Pines PINES E  Village VILLGE E 
Park PK E  Vista VISTA E 
Parkway PKY E  Voie VOIE F 
Pathway PTWAY E  Walk WALK E 
Place PL E  Way WAY E 
Place PLACE F  Wharf WHARF E 
Plateau PLAT E  Wood WOOD E 
Plaza PLAZA E  Wynd WYND E 
Port PORT E     
Point PT E     
Pointe POINTE F     
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Appendix C: Street Types and Street Directions (cont’d)  
 
Street Directions 
 
Street Directions used in the CanMap® suite of products correspond to the standard abbreviations used 
by Canada Post.   The Language column distinguishes between street types in English (E) and street 
types in French (F). 
 
Street Direction Abbreviation Language 

East E E 
Est E F 
Nord N F 
NordEst NE F 
NordOuest NO F 
North N E 
NorthEast NE E 
NorthWest NW E 
Ouest O F 
South S E 
SouthEast SE E 
SouthWest SW E 
Sud S F 
SudEst SE F 
SudOuest SO F 
West W E 
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Appendix D: Cartographic Road and Rail Classificati ons  
 
 

Carto #  Carto Name Description 
1 Expressway Expressways and 400 series highways, e.g. Highway 401, Don Valley 

Parkway 
2 Primary Highway Primary Highway, e.g. Highway 7, Highway 11 

3 Secondary Highway Secondary Highways 

4 Major Road Major road or Arterial road, e.g. Bayview Ave 

5 Local Road Subdivision road in a city or gravel road in a rural area 

6 Trail  Trails 

10 Main Main Railway and Transit Lines (includes segments of rail that are 
shared with transit) 
 

11 Sidetrack Sidetrack of Main Railway Route 

12 Abandoned Abandoned sections of Main Railway Route 

13 Transit Transit lines that are not shared with Railway lines 
 

20 Ferry Route Approximate travel route of Ferry  

21 Ferry Ramp Ferry Ramp 

22 Ice Road Approximate travel route of Ice Road 
23 Ice Ramp Ice Ramp 
24 Ferry Route/Ice Road Approximate travel route of Ferry/Ice Road 
25 Ferry/Ice Ramp Ferry/Ice Ramp 
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Appendix E: Joining the rds Layer and rds_lut Table   

 
To view the AREArds data linked to the AREArds_lut data the user must complete a manual join. 
 
MapInfo  
 

� Open both the AREArds data file and the 
AREArds_lut data file in MapInfo. 

� Select ‘Query’> ‘SQL Select…’ 
� Complete the following query in the Query 

Menu (See Figure 1) 
� Select * from AREArds, AREArds_lut where 

AREArds.UniqueId = AREArds_lut.Rds_Id 
� ‘Verify’ the SQL query and if valid, press 

‘OK’.  
 

Once the query result has been obtained you can 
then view the joined tables e.g. ‘Joined_Results’ via 
the Info Tool in the Map Window or through the 
‘Joined_Results’ Table Browser.  
 

To create a permanent join simply save the joined 
tables as a new MapInfo Table.  
 
 
ArcView  
 

� With the project file open, click on the Window menu and select the project (AREArds.apr) to 
display the project window. 

� With the project window now displayed select the ‘Tables’ icon.  Click on the ‘Add’ button, locate 
and open the AREArds_lut data table you wish to join. 

� With the AREArds_lut table displayed click on the field (Rds_Id) that will be used to join the 
AREArds_lut table to the AREArds data table.  Now return to the View with the AREArds file. 

� Click on the AREArds theme in the legend to make it active. 
� Click on the ‘Open Theme Table’ button to display the AREArds attribute table (or choose Theme 

from the Table menu). 
� Click on the field that will be used to join the AREArds data table (UniqueId). 
� Finally, click on the Join button (or choose Join from the Table menu) 

 
When you scroll along the AREArds attribute table you will notice the AREArds_lut data has been joined.  
Additional data tables can be joined, so that many table attributes can be shown at one time. To undo the 
joins between the data tables click on the AREArds attribute table making it active and from the ‘Table’ 
menu select ‘Remove All Joins’. 
  

                                                      
1 May have been enhanced by removing points from water bodies 

Figure 6: Joining MapInfo Tables 
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Appendix F: Joining the rds Layer and rds_lut Table  (cont’d)  
 
ArcGIS  
 

� Open the appropriate project file 
(AREArds.mxd). 

� Select the ‘Add Data’ button to open the 
corresponding attribute data file 
(AREArds_lut.dbf) you wish to join. 

� Select the AREArds theme, right click and 
select ‘Joins and Relates’ selecting 
‘Join…’ from the sub-menu of choices. 

� Complete the ‘Join Data’ GUI as shown 
below using the UniqueId and Rds_Id 
fields as the common field between the 
tables.  Once complete hit ‘OK’. 

� Once the join is complete select the 
AREArds theme, right click and select 
‘Open Attribute Table’.  Once open, you 
can now scroll through the results of the 
join. 

� Additional data tables can be joined, so 
that many table attributes can be shown at 
one time.  To undo the joins between the 
data tables select the AREArds attribute 
table, right click and select ‘Joins and 
Relates’ selecting ‘Remove Join(s)’ from 
the sub-menu of choices. Select the table 
you wish to remove the join from the list 
provided (i.e. AREArds_lut.dbf). 

 
 
 
 

 
 Figure 7: Joining Layers in ArcGIS. 

 


